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Chapter 538

GEE Tests for Two
Correlated Proportions
with Dropout
Introduction
This procedure provides power analysis and sample size calculation for studies that use a paired design that yield
two binary outcomes, one of which may be incomplete. That is, in some pairs, the second observation is missing.
The data analysis will use a mixed logistic regression model that is solved with GEE.
With complete data, the standard analysis is McNemar’s Test (see McNemar (1947)), and PASS includes several
procedures that analyze that test statistic. McNemar’s Test requires that observations with one or two missing
observations must be discarded. Zhang, Cao, and Ahn (2014) present a closed-form sample size formula for the
case when some data pairs include missing values in the second observation. This is often referred to as dropout.
Another method, also available for sample size calculation in PASS, deals with the important case in which all
missing values occur in the second observation. We refer to this as dropout. We refer to that procedure for further
details.

Technical Details
Consider the following table that summarizes the results of a paired design in which one observation of the pair is
designated as a treatment and the other is designated as a standard.
Standard
Treatment
Yes
No
Total

Yes
P11
P01
Ps

No
P10
P11
1 - Ps

Total
Pt
1 - Pt
1

Our formulation comes from Zhang, Cao, and Ahn (2014). Denote a binary observation by 𝑌𝑌𝑖𝑖𝑖𝑖 , where 𝑗𝑗 =
0 (for 𝑠𝑠) and 1 (for 𝑡𝑡) t, s gives the group and i = 1, 2, …, N gives the subject. A “success” is represented by 𝑌𝑌𝑖𝑖𝑖𝑖 =
1 and a “failure” by 𝑌𝑌𝑖𝑖𝑖𝑖 = 0.
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GEE Approach
Let 𝑃𝑃�𝑌𝑌𝑖𝑖𝑖𝑖 = 1� = 𝑝𝑝𝑖𝑖𝑖𝑖 . The GEE method models 𝑝𝑝𝑖𝑖𝑖𝑖 by the mixed logistic regression
𝑝𝑝𝑖𝑖𝑖𝑖
log �
� = 𝛽𝛽1 + 𝛽𝛽2 𝑗𝑗
1 − 𝑝𝑝𝑖𝑖𝑖𝑖

The regression coefficient 𝛽𝛽2 is equal to the log odds ratio of the two response rates. It is given by
𝑝𝑝𝑖𝑖𝑖𝑖
𝑝𝑝𝑖𝑖𝑖𝑖
� − log �
�
𝛽𝛽2 = log �
1 − 𝑝𝑝𝑖𝑖𝑖𝑖
1 − 𝑝𝑝𝑖𝑖𝑖𝑖

The null hypothesis 𝐻𝐻0 : 𝛽𝛽2 = 0 corresponds to 𝐻𝐻0 : 𝑝𝑝𝑖𝑖𝑖𝑖 = 𝑝𝑝𝑖𝑖𝑖𝑖 . The alternative hypothesis is 𝐻𝐻1 : 𝛽𝛽2 ≠ 0 or 𝐻𝐻1 : 𝑝𝑝𝑖𝑖𝑖𝑖 ≠
𝑝𝑝𝑖𝑖𝑖𝑖 .
Zhang, Cao, and Ahn (2014) provide the following formula for the overall sample size for a two-sided test
𝑁𝑁 =

2

𝜎𝜎 2 �𝑧𝑧1−𝛼𝛼 + 𝑧𝑧1−𝛽𝛽 �
2

𝛽𝛽22

where and 𝛼𝛼 is the probability of a type-I error and 𝛽𝛽 is the probability of a type-II error.

The variance is given by

𝜎𝜎 2 =

𝑉𝑉𝑉𝑉 + (𝑃𝑃𝑃𝑃𝑃𝑃)𝑉𝑉𝑉𝑉 − 2(𝑃𝑃𝑃𝑃𝑃𝑃)𝜌𝜌√𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉
(𝑃𝑃𝑃𝑃𝑃𝑃)𝑉𝑉𝑉𝑉𝑉𝑉𝑉𝑉

where Pmt is the proportion of the second observation missing, 𝑉𝑉𝑉𝑉 = 𝑃𝑃𝑃𝑃(1 − 𝑃𝑃𝑃𝑃), 𝑉𝑉𝑉𝑉 = 𝑃𝑃𝑃𝑃(1 − 𝑃𝑃𝑃𝑃), and 𝜌𝜌 is the
within-subject correlation coefficient.

Estimating 𝝆𝝆
The relationship between P11 and 𝜌𝜌 is

𝜌𝜌 =

𝑃𝑃11 − 𝑃𝑃𝑠𝑠 𝑃𝑃𝑡𝑡

�𝑃𝑃𝑠𝑠 𝑃𝑃𝑡𝑡 (1 − 𝑃𝑃𝑠𝑠 )(1 − 𝑃𝑃𝑡𝑡 )

where P11 is the joint probability that both observations are equal to one.
Using this relationship, values of 𝜌𝜌 can be entered and transformed to the corresponding value of P11. The only
concern is that values of 𝜌𝜌 be used that limit P11 to be between 0 and 1.

The lower and upper limits of the correlation are

(1 − 𝑃𝑃𝑠𝑠 )(1 − 𝑃𝑃𝑡𝑡 )
𝑃𝑃𝑠𝑠 𝑃𝑃𝑡𝑡
,− �
𝜌𝜌𝐿𝐿 = max �−�
�
(1 − 𝑃𝑃𝑠𝑠 )(1 − 𝑃𝑃𝑡𝑡 )
𝑃𝑃𝑠𝑠 𝑃𝑃𝑡𝑡
𝑃𝑃𝑠𝑠 (1 − 𝑃𝑃𝑡𝑡 ) 𝑃𝑃𝑡𝑡 (1 − 𝑃𝑃𝑠𝑠 )
,�
𝜌𝜌𝐿𝐿 = min ��
�
𝑃𝑃𝑡𝑡 (1 − 𝑃𝑃𝑠𝑠 ) 𝑃𝑃𝑠𝑠 (1 − 𝑃𝑃𝑡𝑡 )
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Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that you will be concerned with.

Solve For
Solve For
This option specifies the parameter to be solved for from the other parameters. The parameters that may be
selected are Power, Sample Size, or Effect Size.
Note that the value selected here always appears as the vertical axis on the charts.
The program is set up to calculate power directly. To find appropriate values of the other parameters, a binary
search is made using an iterative procedure until an appropriate value is found.

Test
Alternative Hypothesis
Specify the direction of the alternative hypothesis. The choices are:
•

Two-Sided (Pt ≠ Ps)
Refers to a two-sided test in which the alternative hypothesis is of the type H1: Pt - Ps ≠ 0.

•

One-Sided (Pt < Ps)
Refers to a lower-tailed, one-sided test in which the alternative hypothesis is of the type H1: Pt - Ps < 0.

•

One-Sided (Pt > Ps)
Refers to an upper-tailed, one-sided test in which the alternative hypothesis is of the type H1: Pt - Ps > 0.

Warning
For one-sided tests, the direction you select must match the values of Pt and Ps you enter. For example, if you
select H1: Pt - Ps < 0, then the value of Pt should be less than the value of Ps.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
If your only interest is in determining the appropriate sample size for a confidence interval, set power to 0.5.
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Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected.
Values must be between zero and one. Usually, the value of 0.05 is used for two-sided tests and 0.025 for onesided tests.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size
N (Number of Pairs)
Enter one or more values for N, the number of pairs in the study. If you enter a list of values, a separate analysis is
done for each value.
Range
N>1
Examples: 10 20 30 40 or 20 to 200 by 20.

Effect Size – Marginal Probabilities (Pt, Ps)
Pt Input Type
Indicate what type of values to enter to specify Pt, the group 1 event probability. Regardless of the entry type
chosen, the same test statistic is used in the power and sample size calculations. This option is simply given for
convenience in specifying the Pt.
The choices are
•

Pt
Enter values for Pt directly.

•

Difference (Pt - Ps)
Enter values for the difference (Pt - Ps) and values for Ps. The corresponding value of Pt will be computed
from these two values.

•

Ratio (Pt / Ps)
Enter values for the ratio (Pt / Ps) and values for Ps. The corresponding value of Pt will be computed from
these two values.

•

Odds Ratio (Ot / Os)
Enter values for the odds ratio (Ot / Os) and values for Ps. The corresponding value of Pt will be computed
from these two values.
Note that Ot = Pt / (1 - Pt) and Os = Ps / (1 - Ps)

Pt (Prob (Yit = 1))
Enter a value for the probability that Yit = 1 under the alternative hypothesis, H1. Yit is the binary response of
observation t (i = 1, ..., N). In a Pre-Post design, observation t would represent the Posttest.
Values must be between 0 and 1.
You can enter a single value such as 0.1 or a series of values such as 0.1 0.2 0.3 or 0.1 to 0.5 by 0.1.
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Note
This value must be different from Ps.
Difference (Pt - Ps)
Enter the difference between Pt and Ps. This difference is used with Ps to calculate the value of Pt using the
formula: Pt = Diff + Ps.
You can enter a single value such as 0.05 or a series of values such as 0.03 0.05 0.10 or 0.01 to 0.09 by 0.02.
Range
Differences must be between -1 and 1. They cannot take on the values -1, 0, or 1. The resulting value of Pt must
be between 0 and 1. If it is not, the scenario is skipped.
Ratio (Pt / Ps)
Enter the ratio of the two probabilities Pt and Ps. This ratio is used with Ps to calculate the value of Pt using the
formula: Pt = Ratio x Ps.
You can enter a single value such as 0.5 or a series of values such as 0.5 0.6 0.7 0.8 or 0.25 to 2.0 by 0.25.
Range
Ratios must be greater than zero. They cannot take on the value of one. The resulting value of Pt must be between
0 and 1. If it is not, it is changed so that it is between 0 and 1.
Odds Ratio (Ot / Os)
This option specifies the odds ratio between the two probabilities Pt and Ps. This value is used with Ps to calculate
the value of Pt.
You can enter a single value such as 0.5 or a series of values such as 0.5 0.6 0.7 0.8 or 1.25 to 2.0 by 0.25.
Range
Odds ratios must be greater than zero. They cannot take on the value of one.
Ps (Prob (Yis = 1))
Enter a value for the probability that Yis = 1 under the both hypotheses, H0 and H1. Yis is the binary response of
observation s, i = 1, ..., N. In a Pre-Post design, observation s would represent the Pretest.
Values must be between 0 and 1.
You can enter a single value such as 0.1 or a series of values such as 0.1 0.2 0.3 or 0.1 to 0.5 by 0.1.
Note
Ps must be different from Pt. That is, you cannot have a zero effect size.
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Effect Size – Joint Probability (P11)
P11 Input Type
Indicate how to specify P11, the joint probability that Yis = 1 and Yit = 1. Since this value is seldom known at the
time a study is planned, it is usually easier to specify the within-subject correlation, ρ, and let the program
compute P11 from it.
Regardless of the entry type chosen, the same test statistic is used in the power and sample size calculations. This
option is simply given for convenience in specifying P11.
The choices are
•

ρ (Within-Subject Correlation)
Enter values for ρ, the within-subject correlation.

•

P11 (Prob (Yit = Yis = 1))
Enter values for P11 directly. This option will usually be used when power is being calculated after an
experiment has been run or a reliable estimate of P11 is available from a previous, or pilot, study.

ρ (Within-Subject Correlation)
Enter one or more values for ρ, the correlation of observations within the same subject (pair).
At least one value must be entered. If multiple values are entered, a separate analysis is performed for each value.
Range
-ρL < ρ < ρU. A value near 0 indicates low correlation. A value near 1 indicates high correlation. The boundaries
ρL and ρU are based on the marginal probabilities Pt and Ps. They guarantee that P11 will be within a suitable
range.
Examples are a single value such as 0.5 or a list of values such as 0.5 0.6 0.7 or 0 to 0.9 by 0.1
P11 (Prob (Yit = Yis = 1))
Enter one or more values for P11, the joint probability that Yis = 1 and Yit = 1. This option will usually be used
when power is being calculated after an experiment has been run or a reliable estimate of P11 is available from a
previous, or pilot, study.
At least one value must be entered. If multiple values are entered, a separate analysis is performed for each value.
Range
0 < P11 < 1.
Examples are a single value such as 0.2 or a list of values such as 0.1 0.2 0.3 or 0.1 to 0.9 by 0.1

Dropout (Missing)
Pmt (Prob (Yit = Missing))
Enter one or more values for the probability of obtaining a missing value for Yit when Yis is non-missing.
At least one value must be entered. If multiple values are entered, a separate analysis is performed for each value.
Range
0 ≤ Pmt < 1.
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Example 1 – Calculating Sample Size
Suppose a dental clinical trial is being planned in which two sites are selected in each subject’s mouth. One site is
randomly assigned to receive the treatment intervention and the other is assigned the standard intervention. The
trial is being conducted to compare two treatments for gingivitis. In the study, suppose Ps = 0.5; Pt = 0.6, 0.65,
0.7; ρ = 0, 0.2, 0.4, 0.6, 0.8; alpha = 0.05; and power = 0.9. Similar studies have had Pmt = 0.1. Sample size is to
be calculated for a two-sided test.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may then make the appropriate entries as listed below, or open
Example 1 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Alternative Hypothesis ............................ Two-Sided (Pt ≠ Ps)
Power ...................................................... 0.90
Alpha ....................................................... 0.05
Pt Input Type .......................................... Pt
Pt (Prob (Yit = 1)) .................................... 0.6 0.65 0.7
Ps (Prob (Yis = 1)) .................................. 0.5
P11 Input Type ....................................... ρ (Within-Subject Correlation)
ρ (Within-Subject Correlation) ................ 0 0.2 0.4 0.6 0.8
Pmt (Prob (Yit = Missing)) ...................... 0.1

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results ────────────────────────────────────────────────────────────
Test:
Mixed Logistic Regression using GEE
Alternative Hypothesis:
Two-Sided (Pt ≠ Ps)

Power
0.9002
0.9005
0.9002
0.9007
0.9020
0.9005
0.9006
0.9007
0.9010
0.9017
0.9000
0.9015
0.9004
0.9032
0.9018

Total
Sample
Size
N
552
448
343
239
135
244
198
152
106
60
136
111
85
60
34

Pt
0.6000
0.6000
0.6000
0.6000
0.6000
0.6500
0.6500
0.6500
0.6500
0.6500
0.7000
0.7000
0.7000
0.7000
0.7000

Ps
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000
0.5000

Pt-Ps
Diff
0.1000
0.1000
0.1000
0.1000
0.1000
0.1500
0.1500
0.1500
0.1500
0.1500
0.2000
0.2000
0.2000
0.2000
0.2000

Within
Subj
Corr
ρ
0.0000
0.2000
0.4000
0.6000
0.8000
0.0000
0.2000
0.4000
0.6000
0.8000
0.0000
0.2000
0.4000
0.6000
0.8000

Joint
Prob
Both
Prob
Obs=1 Discord
P11 P01+P10
0.3000 0.5000
0.3490 0.4020
0.3980 0.3040
0.4470 0.2061
0.4960 0.1081
0.3250 0.5000
0.3727 0.4046
0.4204 0.3092
0.4681 0.2138
0.5158 0.1184
0.3500 0.5000
0.3958 0.4083
0.4417 0.3167
0.4875 0.2250
0.5333 0.1334

Prob
Trt
Miss
Pmt
0.1000
0.1000
0.1000
0.1000
0.1000
0.1000
0.1000
0.1000
0.1000
0.1000
0.1000
0.1000
0.1000
0.1000
0.1000

Alpha
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
0.050
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Report Definitions
Power is the probability of rejecting a false null hypothesis.
Total Sample Size N is the total number of subjects in the study.
Pt is the probability of a "true" response in the treatment observation.
Ps is the probability of a "true" response in the standard observation.
Diff (Pt-Ps) is the difference between the two probabilities.
ρ (Within Subj Corr) is the correlation between the two observations within a subject.
P11 (Joint Prob Both Obs=1) is the joint probability that both observations in a pair are true (equal to '1').
P01+P10 (Prob Discord) is the probability that of obtaining a discordant event. It is provided to allow easy
comparison of these results with those of McNemar's test.
Pmt (Prob Trt Miss) is the probability that the treatment observation is missing and the standard observation is
observed.
Alpha is the significance level of the test: the probability of rejecting the null hypothesis of equal probabilities
when it is true.
Summary Statements ─────────────────────────────────────────────────────────
When all observation pairs are complete, McNemar's test is usually used. When some of the treatment
observations are missing, a GEE test statistic is used to test the difference between two response proportions. If
the GEE test is used, a sample of 552 subjects achieves 90% power at a significance level of 0.050 to detect a
difference of 0.1000. The response proportion of the treatment observation is 0.6000 and of the standard
observation is 0.5000. The joint probabilites are calculated from Pt, Ps, and a within-subject correlation of 0.0000.
The proportion of missing observations is 0.1000 in the treatment observations.

This report gives the sample size for each of the requested scenarios.

Plots Section

These plots show the sample size for the various combination of the other parameters.
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Example 2 – Validation using Zhang, Cao, and Ahn (2014)
Zhang, Cao, and Ahn (2014) page 119 present Table 3 which provides examples that we can use to validate this
procedure. The second set of three rows, last column, has the following settings: Ps = 0.1; Pt = 0.2; ρ = 0.0, 0.15,
0.3; alpha = 0.05; power = 0.8; and Pmt = 0.4. Sample size is calculated for a two-sided test. The resulting
sample sizes are 257, 228, and 198.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the procedure window. You may then make the appropriate entries as listed below, or open
Example 2 by going to the File menu and choosing Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Alternative Hypothesis ............................ Two-Sided (Pt ≠ Ps)
Power ...................................................... 0.8
Alpha ....................................................... 0.05
Pt Input Type .......................................... Pt
Pt (Prob (Yit = 1)) .................................... 0.2
Ps (Prob (Yis = 1)) .................................. 0.1
P11 Input Type ....................................... ρ (Within-Subject Correlation)
ρ (Within-Subject Correlation) ................ 0 0.15 0.3
Pmt (Prob (Yit = Missing)) ...................... 0.4

Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Test:
Mixed Logistic Regression using GEE
Alternative Hypothesis:
Two-Sided (Pt ≠ Ps)

Power
0.8001
0.8015
0.8015

Total
Sample
Size
N
257
228
198

Pt
0.2000
0.2000
0.2000

Ps
0.1000
0.1000
0.1000

Pt-Ps
Diff
0.1000
0.1000
0.1000

Within
Subj
Corr
ρ
0.0000
0.1500
0.3000

Joint
Prob
Both
Prob
Obs=1 Discord
P11 P01+P10
0.0200 0.2600
0.0380 0.2240
0.0560 0.1880

Prob
Trt
Miss
Pmt
0.4000
0.4000
0.4000

Alpha
0.050
0.050
0.050

PASS matches the sample sizes of 257, 228, and 198. The procedure is validated.
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